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Entering Your Key
Entering your trial key allows you to save your projects 
and print them during your evaluation period.  Entering 
your license key allows you do the same, except with-
out any time limitations. 

1. Start by opening up an image in Photoshop. 
2. Go to Filters -> Topaz Labs -> Lens Effects -> Menu
 -> Enter key. 
3. You can then copy and paste or type your key in.

Important: To install the product on a second comput-
er, you will need to download Topaz Lens Effects and 
then enter your same license key.

Host-Specific Installation
Topaz Lens Effects is also compatible with Lightroom, 
Aperture and iPhoto.  To use Lens Effects in any of 
these programs you will need to download and install 
the free Topaz Fusion Express compatibility add on.  
You can get it online at: www.topazlabs.com/down-
loads

In Windows, Topaz Lens Effects is supported by most 
host applications that support Photoshop plug-ins.  
This includes Paint Shop Pro, Photo Impact and Irfan-
view, although there are additional host programs that 
may also support Topaz Lens Effects. 

To install Lens Effects in either Paint Shop Pro, Photo 
Impact, or Irfanview first download Topaz Lens Effects 
to the default location.  Then, to configure it into each 
program, follow the host-specific instructions on the 
next page. 

Topaz Lens Effects is a Photoshop plug-in, which means 
it won’t run by itself and requires a compatible host 
program. 

To Install
1. Close Photoshop or other image editing program if 
you are using it. 

2. Double-click on the Topaz Lens Effects folder to 
access the  installer, and then follow the on-screen 
instructions. 

3. Your Topaz Lens Effects plug-in will automatically be 
installed in your Photoshop plug-ins folder. 

4. After the installation, you will need to enter your 
license or trial key. 

Important for Mac Users: 
After installation, Topaz Lens Effects will be installed in 
the following folder: “ Macintosh HD -> Library -> Ap-
plication Support -> Topaz Labs -> Lens Effects”.

If your Photoshop is installed in a customized location, 
you will need to manually create a shortcut (alias) link 
inside folder “<Photoshop install folder> -> Plug-ins” 
that links to “ Macintosh HD -> Library -> Application 
Support -> Topaz Labs -> Lens Effects -> Plug-ins”.

Installation

             Mac Dmg           Windows exe
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How to install Topaz Lens Effects in Paintshop Pro 
1. First launch PaintShop Pro / Photo Impact.

2. Go to Menu file -> Preferences -> File Locations. 
Select “Plug-ins” from the “File Types” list and click 
“Add”. 

Installation
3. Choose C: \ Program Files \ Topaz Labs \ Topaz Lens 
Effects plug-ins and click “OK”. 

4. Topaz Lens Effectsis now available to use. Simply go 
to Effects -> Plug-ins and select “Lens Effects”.
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How to install Topaz Lens Effects in Photo Impact 
1. First launch  Photo Impact.

2. Go to File -> Preferences -> General or use shortcut 
key F6. 

3. Select Plug-ins from the Categories list. 

Installation
Then click on the           button and browse to find the 
Lens Effects plug-in folder located in:  C:\Program Files\
Topaz Labs\Topaz Lens Effects plug-ins and click “OK”. 

4. Restart Photo Impact. Go to Menu -> Effect to access
the plug-in.
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How to install Topaz Lens Effects in Irfanview
1. Make sure that you have downloaded and installed 
the 8bf plug-in add-on, available on the Irfanview 
webpage. (http://www.software.com/irfanview-plugin)

2. Open Irfanview and go to Image -> Effects -> Adobe 
8BF filters. 

3. In the screen that pops up, select “Add 8BF filters” 
and navigate to the C:\Program Files\Topaz Labs\To-
paz Lens Effects \Plug-ins folder and click “OK”. You 
will then see “Topaz Lens Effects” in the Available/
Loadable 8BF Filters section. 

4. To use Topaz Lens Effects in the future, simply go to 
Image -> Effects> Adobe 8BF filters again and select 
“Topaz Lens Effects”.

Installation
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2. Click on the Start Menu and select Control Panel.
3. Select Programs, then Uninstall a Program.

4. Select Topaz Lens Effects and click remove. 

 
Windows 7*

1. Quit Photoshop (or other editing program).

2. Click on the Start Menu and select Control Panel -> 
Programs -> Programs and Features. 

3. Select Topaz Lens Effects and click uninstall. 

*Please note that if you also have the 64-bit version of 
Lens Effects installed, then you will need to first unin-
stall this version before you can uninstall the regular 
version. 

To uninstall Topaz Lens Effects follow these instruc-
tions:

Mac
1. Quit Photoshop (or other editing program).

2. Navigate to the Topaz Labs support files and frames 
located at: Macintosh HD -> Library -> Application Sup-
port -> Topaz Labs. 

3. Locate the Topaz Lens Effects file and move it to the 
trash. You will need to enter your system password to 
OK this change. 

4. Navigate to your Photoshop plug-ins folder located 
at: Applications -> Photoshop -> Plug-ins

5. Locate any leftover Topaz Lens Effects files and 
move it to the trash. 

Windows XP*

1. Quit Photoshop (or other editing program).

2. Click on the Start Menu and select Control Panel.

3. Double-click on Add / Remove programs.

4. Select Topaz Lens Effects and click remove. 

Windows Vista*

1. Quit Photoshop (or other editing program).

Uninstalling

Before - Old School Haze After - Old School Haze
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Topaz Lens Effects
About Topaz Lens Effects
Topaz Lens Effects allows you to easily achieve the look 
of speciality cameras, filters and lenses without the 
need for additional, expensive equipment or longer 
Photoshop processing times.

Some of the popular effects you can achieve with 
Lens Effects include blurred backgrounds, miniatures, 
old school camera style and more.

With Topaz Lens Effects, you can achieve a variety of 
camera, lens and filter effects and adjustments such as: 

The Primary Functions of Topaz Lens Effects Include: 

1. Simulate realistic lens, filter & specialty camera 
effects

2. Change and emphasize focal point in your image

3. Create and adjust depth of field in images

4. Minimize distracting backgrounds and other 
elements by selectively applying bokeh and vignettes
 
5. Balance, enhance and subtract color

6. Add creative effects like motion blur and distortion

Introduction

Visit the Lens Effects Gallery to see more examples:
http://gallery.topazlabs.com/keyword/lenseffects

• Bokeh                  • Vignette
• Single Tone                                • Dual Tone
• Graduated Color                      • Graduated Neutral Density
• Creative Blur                             • Motion Blur
• Dual Focus                               • UV/Haze 
• Streaks                               • Diffusion
• FishEye                               • Toy Camera

Before - Pinhole Effect

After - Pinhole Effect
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Lens Effects Features

1. Smart Brush.  Use for easy selective adjustments.

2. Apply button. Stack effects and presets. 

3. Split Screen. Use the 2-screen split view for easy 
before and after comparison. 

4. Effect Center. Single-click ability for selecting effect 
center. 

5. Click to position. Click anywhere on slider to jump 
to that adjustment value.

6. Style user interface.  Select from a light or dark 
color scheme.

7. Auto Updater.  Get software updates instantly.

8. Snap / Recall buttons.  Save up to 99 snapshot set-
tings for comparison. 

9. Undo / Redo buttons. 

10. Collapsible side panels.  Expand and collapse the 
preset panel and the tool panel for an adjustable 
workspace. 

11. Collapsible tabs.  Open and close the parameter 
tabs as you need them. 

12. Preset Enable / Disable option.  Option to enable 
or disable the preset preview processing at program 
startup. 

13. Presets Layout.  New preset format with single 
preset preview window. 

14. Preset Navigation.  Use the up / down arrow keys 
to navigate the preset list and display the selected 

preset thumbnail (in preset preview window). Use 
the return (Enter) key to apply the currently selected 
preset.

15. Enable / Disable Tool Tips.  Option to enable or dis-
able the pop up tool tips. 

16. Quick Slider Reset.  Double click on the slider 
name to reset default slider values.

Introduction

Before - Bokeh Selective

After - Bokeh Selective
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When creating bokeh effects you will use the Smart 
Brush to create depth maps - allowing you to select 
any focal point within your image and put the empha-
sis where you want it. 

Use the depth map feature to indicate the relative dis-
tance of objects in the image. Nearer objects should 
be painted in black, middle objects gray and farthest 
should be painted white. Several tones of gray may be 
used to indicate relative distances.

NEW: Smart Brush
Topaz Lens Effects includes new smart brush techol-
ogy. The smart brush, used to create depth-maps, is 
designed to help you easily and effectively achieve 
selective adjustments during your workflow. This tool 
can be used in brush mode or gradient mode. 

New Features

Original Image

Depth-Map (brush mode)
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appropriate slider accordingly. Once your values are 
set  you can set your brush size - using the selection 
buttons or the slider. Then go ahead and draw your 
gradient across your image.

Refining Your Depth Map Selections
If you switch back to the Brush mode (uncheck the 
Use Gradient Brush box) this will allow you to access 
the grayscale color picker.

This tool makes it easy to pick the depth value based 
on the adjacent region’s depth value, eliminating the 
guessing game in both picking a desired depth value 
and in selecting the focus area based on the Depth 
value.

So, in short, if you want to paint an area in a certain 
tone, use the picker-tool (dropper icon) to click on the 
area, the correct depth-value will be selected.

The Gradient Brush tool allows you to easily create 
smooth gradients in the Depth Map by simply brush-
ing (click and drag) on the Depth Map.

Using the Smart Brush 
When using the Smart Brush feature it is best to first 
create gradient. After that you can make more de-
fined selections in your image. 

To use the gradient feature, you will need to select 
your starting and ending values. The values range 
from 0-255 (near to far respectively). You can set the 
values using the default buttons or by moving the 

The depth map feature is accessible when you choose 
Bokeh SLR or Bokeh Selective from the Effects menu.

New Features
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New Features
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New Features
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New Features
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As in the other Topaz programs, you also have a pre-
sets panel. You can create and save your own presets. 
You also have the ability to export and import presets 
- allowing you to share with your friends. 

* Default presets that come with the program can not 
be deleted. 

NEW: Effects Menu
Lens Effects introduces a new category called Effects 
which helps to manage your presets - there’s over 120 
presets included in Topaz Lens Effects. 

Each Effect features a set of its own presets that can 
be applied to your image. During your workflow you 
can select the type of effect that you want and then 
choose from one of the included presets in that cat-
egory. 

Each Effect also featurs it’s own set of tools. So as you 
switch between effects, you will notice that the tools 
in your tool panel (on the right side of your program 
interface) will also change accordingly.

New Features

Effects can Not be added.  However, you are able to 
create new presets and add them to any of the default 

effects listed in the Effects Menu. 
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            For this example we 
                                                               used the Bokeh - 
                                                               Selective effect first, 
            to blur the back
            ground a bit, then  
            clicked the Apply 
            button to save this  
            adjustment. 

           Once you click Apply  
           it can Not be undone.

Next, we went to the
Filter - Dual Tone Effect 
in the Effects menu and
selected the Cool to 
Warm I preset .

You can add and apply 
as many effects and 
presets as you’d like. 
Once you are satisfied 
with the changes, click
 “OK” to process the 
image and return to 
Photoshop. 

NEW: Apply Button
Lens Effects features a new Apply button which 
allows you to stack multiple effects and presets 
during the same workflow.

Using the new Apply button is simple and helps speed 
up your overall workflow. Here’s a quick workflow to 
show you how it works. 

New Features

Original Image

After Bokeh Adjustment

After Filter Adjustment
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NEW: Enhanced Sharpening
Lens Effects includes an updated sharpening tool that 
feature a stronger more powerful algorithm that ren-
ders crisp, clear sharpening capabilities. 

Some of the Effects include Sharpening parameters. 
Or you have the option of selectively adding sharp-
ening to your images use the xF Sharpening feature 
found in the Effects Menu. 

New Features

Before Topaz - xF Add Sharpening

After Topaz - xF Add Sharpening

For extended detail and sharpening control be sure 
to check out Topaz Detail and Topaz InFocus:

www.topazlabs.com/products
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NEW: Split Screen View
Lens Effects features a 2-screen split view option for 
easy before and after comparison.

New Features

         Use the single screen button  
   to see the full image preview.  
   Use the 2-split button to see  
   before and after comparison. 
Use the preview navigator (top right of interface) to pan 
the preivew or drag the images around in the preview. 
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The next time you restart Lens Effects your program 
will feature the lighter-colored interface. 

Go to Menu -> Preferences and check the “Use Topaz 
Style” box and restart Lens Effects to re-enable the 
darker color scheme.

NEW: Interface Style 
By default, Lens Effects uses the darker Topaz Style 
interface. However, you have the option in your Lens 
Effects preferences menu to change to a lighter color 
scheme. Simply go to Menu -> Preferences from 
within the Lens Effects program and uncheck the 
“Use Topaz Style” box. 

New Features
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Work Area

Interface (Main View)

1. Presets/Effects
 Preview

5. Settings & Parameters

Although the Topaz Lens Effects interface may look intimidating at first glance, don’t worry: it’s actually quite simple 
and easy to use.  You’ll soon be a pro after experimenting with it for a bit.  In order to make sense of the function of 
each of the various controls, we have divided the interface into a few sections:

1 3
4

5

2. Presets Panel 4. Preview Navigator

Displays previews of 
the included presets & 
effects. 

Controls the editing using sliders 
to adjust the various effects.

Provides “snapshots”
 of pre-defined effects.

Displays the region of the
preview image you are 
currently focused on. 

2

3. Preview Window
Displays the preview of the 
original and adjusted image. 
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Work Area

Interface (Tool Panel View)
Use the small white arrows to expand and collapse the preset panel.   You can click the white arrow            or grab the 

edge of the panel and drag it in or out - note that tool selections will change depending on which effect is selected.
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Work Area

Interface (No Panel View)
Use the small white arrows to expand and collapse the preset and tool panels.   You can click the white arrows                    
or grab the edge of the panels and drag them in or out.
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Work Area

Interface (Preset Panel View)
Use the small white arrows to expand and collapse the tool panel.   You can click the white arrow                or grab the 
edge of the panel and drag it in or out.
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To pan the preview image, click and hold the left 
mouse button on the preview image and drag it 
around.  When you let go of the mouse button, the 
new portion of the image will be processed and the 
result will be displayed. 

Preview Section 
The Preview section is the main window that is cen-
tered in the Lens Effects interface.  The preview 
section shows you the original image and the pro-
cessed preview of the image.  Click on the image in 
the preview window (or use the Original and Preview 
buttons) to switch between the Original and Preview 
tabs and compare the filtered and un-filtered images. 

Work Area

You can also use SPACE bar or your numbered shortcut 
keys “1” and “2” to switch back and forth between your 
filtered and unfiltered image in the preview window.

1
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The “Ctrl +” and “Ctrl –” keys zoom in and out of the 
image, just like in Photoshop.  

You can use the arrow keys to adjust the value of the 
slider that is currently selected.  

A complete list of the shortcut keys can be found in 
the Shortcut Keys section later in this manual.

You can zoom in or out of the preview image by click-
ing the “+”, or “-” buttons below the preview image.
You can also resize the window as well by dragging 
the bottom right corner in and out. 

The “Fit” button will fit the entire image into the pre-
view window. 

The “100%” button will zoom to 100% view. 

If zoomed below 100% the preview image will be inter-
nally resized in order to speed up preview updating.
 

Work Area

Photoshop and other host software support many Image 
Modes, such as Grayscale, RGB, LAB, CMYK, etc.  Images 
can also be 8, 16, or 32 bits per channel. Topaz Lens Effects 
supports both 8 bits per channel and 16 bits per channel. 
Lens Effects supports RGB mode only.  To work on black-
and-white images, first convert them to RGB mode.

Use Lens Effect’s creative enhancement presets 
to enhance the focal point in your image. 
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Work Area

Effects & Presets
Effects & Presets are a great way to speed up and 
simplify the whole process of using Topaz Lens 
Effects.  Effects & Presets are set previews with 
previously defined settings that you can recall and 
reapply at any time. 

We’ve included some default effects and presets for 
you and, although they won’t work for every single 
photograph, they serve as excellent starting points 
for customized tweaking.  

Applying Effects & Presets 
Applying a default Effect and preset is easy and intui-
tive.  Simply clicking on a preset will change all the 
settings in Topaz Lens Effects to match those in the 
selected preset. 

To get the exact results you want, you may still want 
to go through the tabs and tweak the parameters.

Adding Presets
Sometimes it’s convenient to be able to define pre-
sets and save your settings for later use.  To do this, 
first adjust the Topaz Lens Effects parameters until 
you’re satisfied with the result.  Then, click on “Save”. 

 
 

1. Presets Preview
The removable preview 
window displays
preset previews.  Click 
Hide / Show to expand or 
collapse the preset pre-
view window at anytime 
during your workflow.2

2. Effects & Presets 
List
Lists all of the saved pre-
sets available for use. 

1

3. Preset Options
The preset options al-
low you to save your 
presets, delete presets 
(default presents cannot 
be deleted), import new 
presets and export your 
saved presets to share 
with your friends. 

Remember that you can easily expand or collapse the presets 
panel by clicking on the small white arrow on the edge of the 
panel or by grabbing the panel edge and dragging it in or out. 3
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Work Area
Next, enter a preset name, select the type of image 
that it is good for and then enter a description and 
click “OK”.  You can also select a second image cat-
egory type that the preset is good for. 

Note that if the name you’ve entered is the same as a 
preset you’ve already defined then you will be asked if 
overwrite the previous one. 

Your preset will be automatically saved as a new file 
with a “.tpp” extension in the Topaz Lens Effects Pre-
sets menu and the preview is automatically generat-
ed.  To apply it later, just click it like any other preset. 

Deleting Presets
If you’d like to delete a preset, use the Delete option 
with your desired preset selected. 

Please Note: Default presents cannot be overriden or 
deleted.  Once you delete a preset it or overwrite it, it 
cannot be retrieved. 

Saved presets are located in the Topaz Lens Effects “Presets” 
folder:
C:\Program Files\Topaz Labs \ Topaz Lens Effects \ Presets unless 
you’ve opted to install Topaz Lens Effects into a different direc-
tory.
 
Mac users have this folder at: HD / Library / ApplicationSupport /
TopazLabs / Lens Effects / Presets. 
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Work Area
Exporting Presets
To export the preset file to a certain location, click 
“Export”. 

Name your preset and save it to your desktop or 
other specified location that you have reserved for 
saved presets.

You can then share this preset file with others who 
may then import it. 

Importing Presets
To import a preset file, click the “Import” button.

This will open up a “Browse” box to import a saved 
preset from your computer into Topaz Lens Effects.  
This is useful if you have downloaded a preset file 
that you’d like to use. 

Sharing Presets
Feel free to share your saved presets by emailing 
them to your friends and having them put it into their 
Topaz Lens Effects Presets folder.  

Visit the Topaz Labs Blog which features the latest 
Photography, software and design information including 

tutorials, videos, and thoughts about both Topaz and 
non-Topaz topics.
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Work Area

Tools
You will use the various tools in the tool panel during 
your workflow to make your image adjustments.

1. Preview Navigator - Displays the region of the
preview image you are currently focused on.

2. Zoom Buttons - Use the zoom buttons to zoom in 
and out of your image.  Or you can also set your image 
to fit the preview window or to view it at 100%. 

3. Undo and Redo buttons - move back and forward 
through previous adjustments.

4. Snap and Recall buttons.  Save up to 99 snapshot 
settings for comparison. 

5. Sliders and Parameters - Controls the editing pro-
cess using sliders to adjust the various effects.

6.  Reset All.  Reset all of the sliders values back to the 
default value.  

7. Apply. Used to stack the effects and presets you 
want to apply to your image (during the same work-
flow). 

1

5

3

2

6Have more questions about Topaz Lens Effects or 
any of the other Topaz software programs?

 Check out the new Topaz Knowledge Base online at: 
www.topazlabs.com/support/kb

4

7
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Check for Updates
Checks for available Topaz Lens Effects updates. 

Click the Show Details button to get find out what’s 
included in the update before you install. 

Enter Key

Menu
You can access Topaz Lens Effects’ menu by clicking on 
the “Menu…” button at the bottom of the interface. 

Preferences
Select this to enable or disable the program tool tips 
or the Auto-Update feature. You can also change your 
interface color scheme to a lighter/darker appear-
ance. 

Work Area
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Enter Key 
Select this to enter your trial or purchased license key. 

What’s This?
Select this (or click F1) then click on a feature in the 
Lens Effects interface to learn more about it. 

Users Guide
Select it to pull up this user guide.

Tech Support
Brings you to the Topaz Labs support page where 
you can request assistance from our support special-
ists, contact our customer service team, retrieve lost 
license keys, or browse through our Knowledge Base. 

Product Info
Select this to go to the Topaz Lens Effects web page 
to learn more about the Topaz Lens Effects plug-in.

Gallery
Select this to open up your Internet browser and go 
to the Topaz Lens Effects image gallery to see other 
user images enhanced with Topaz Lens Effects.

MyTopaz
Brings you to the Topaz community where you can 
connect and interact with other Topaz users.  Here 
you can also participate in discussions and contests, 
and share your favorite Topaz images. 

Tutorials
Brings you to the Topaz Lens Effects tutorials page 
where you can access a variety of helpful video and 
text tutorials.  You can also submit tutorials that you 
created here as well.

About
Select this to see what version of Lens Effects you 
currently have.

Work Area

To connect with other Topaz users, participate in Topaz 
contests and to see the latest tips, tricks and tutorials sign 

up for the new Topaz Forum online at:
 www.topazlabs.com/forum
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Settings & Parameters 

Effects & Presets
Topaz Lens Effects has 18 Effects and over 100 presets 
to help you achieve optimal image results. 

Need to reset your slider values? 

Simply  double-click on the slider name above the slider 
control to instantly reset the slider value to 0. 

Before Topaz

After Topaz
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Settings & Parameters 

Focus Width
Adjusts the horizontal span of the applied blur (from 
the Effect Center). A higher value will include more 
focused area from the Effect Center. 

Focus Height
Adjusts the vertical span of the applied blur (from the 
Effect Center). A higher value will include more focused 
area from the Effect Center. 

Transition
Determines the hardness of the transition between 
the blurred (out-of-focus) background and the focused 
foreground. The higher the value the softer the transi-
tion will be.

Effect Center
1-click center focal-point selection. 

Bokeh - Center Focus
The Bokeh - Center Focus Effect allows you to quickly 
blur your backgound using a 1-click foreground focal-
point selection.  This effect includes default presets and 
two adjustment tabs: Bokeh Adjustmens and Lens Char-
acteristics for the fastest, most effective  workflow. 

Bokeh Adjustments
This parameter allows you to create and control the 
amount and transition of the blur effect. 

Blur Amount
Determines the amount of blur applied to image. The 
higher the value the heavier the blur. 
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Aperture Shape
The Aperture Shape gives you
 the ability to change the shapes 
of the highlights in your blurred 
background. Use this to set the 
number of blades in the selected 
Aperture shape, which controls
 the out-of-focus highlights. The 
higher the blade setting the more 
rounded the hightlights will be.

Lens Characteristics
This parameter allows you to adjust how the blur area 
is rendered and enhance the highlights.

Settings & Parameters 

Chromatic Aberration - light & cool 3-blade

4-blade

5-blade

6-blade

7-blade

8-blade

9-blade

cirlce
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Blade Curvature
Determines the curvature of the aperture blades. 
A higher setting produces a smoother more rounded 
shape - this offers more variation and flexibility with the 
appearance of the 8 different Aperture shapes.

Rotation
Rotates the selected aperture shape.

Creamy
Determines the smoothness of the blur and fill of the 
highlights in your image.

Highlight Boost
Increases the highlights in the image and correlates to 
the Highlight Threshold slider. Use this parameter to 
make the highlights more apparent.

Highlight Threshold
The highlight threshold slider helps determine which 
highlights are affected by the highlight boost slider. 
The lower the threshold slider the more highlights that 
will be affected. 

Chromatic Aberration
The Chromatic Aberration slider allows you to change 
the color fringes around the edges of the highlights 
(aperture shapes) that separate dark and bright points 
in your image. 

The higher you set the Chromatic Aberration slider, the 
warmer the color fringe will be. The lower you set the 
Chromatic Aberration slider, the cooler the color fringe 
will be. 

Settings & Parameters 

Tip: The hightlights in your blurred area are adjustable. 
You can easily make them perfectly solid, hallow or 

anywhere in between. Just adjust the creamy slider to 
change the amount of fill in the highlights. 

-1.00                                          0                                        1.00

Tip: The Hightlight Boost and Highlight Threshold 
sliders will only affect the background blur. 
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Brush Smoothness
Determines the edge smoothness of your brush 
strokes. 

Bokeh - SLR Lens
The Bokeh - SLR Lens Effect. This effect includes de-
fault presets that simulate various camera lenses and 
settings. This effect includes default presets and three 
adjustment tabs: Edit Depth Map, Focal Plane Position 
and Lens Characteristics.

Edit Depth Map (Topaz Smart Brush)
This parameter allows you to create depth maps. Use 
the Smart Brush to identify relative distance of near 
to far objects  - making it easy to select any focal point 
within your image and put the emphasis where you 
want it.

Depth  Value
Paints image depth, using shades of black, white and 
gray. The higher the value the further away it will be. 
The lower the value the closer it is considered.  Selects 
relative distance for the depth map.

Brush Size
Determines the size of the brush. 

Settings & Parameters 

Nearer objects should be painted in black, middle objects 
gray and farthest should be painted white. Several tones 

of gray may be used to indicate relative distances. TIP: 
Remember the ‘Depth Value’ used to paint area(s) you 

want to be in-focus, later in ‘Focal Plane Adjustments’ set 
the ‘Focal Plane Position’ slider to that value.
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Foreground Blur Amount
Determines the amount of blur applied to the fore-
ground.

Background Blur Amount
Determines the amount of blur applied to the back-
ground.

Lens Characteristics
This parameter allows you to adjust how the blur area 
is rendered.

Focal Plane Adjustments
This parameter allows you to adjust which part of the 
image you want to be in focus - similar to focusing a 
camera. 

Select Focal Plane
1-click Focal Plane positioning - or you can use the Focal 
Plane Slider underneath. 

Focal Plane Position
Provides control for focal placement. It is like using the 
focusing ring on a lens to change the area of focus. 

Depth of Field
Increases or decreases the depth of field before/after 
the point of focus. Similiar to changing the aperture of 
a lens (f/1.4, f/8, f/16 etc) 

Settings & Parameters 
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Aperture Shape
Sets the number of blades in the selected Aperture 
shape, which controls the out-of-focus highlights. The 
higher the blade setting the more rounded the hight-
lights will be.

Blade Curvature
Determines the curvature of the aperture blades. A 
higher setting produces a smoother more rounded 
shape.

Rotation
Rotates the selected aperture shape.

Creamy
Determines the smoothness of the blur.

Highlight Boost
Increases the highlights in the image. 

Highlight Threshold
Determines the span of elements affected by the 
highlight boost slider. A larger threshold allows more 
elements to be affected.

Chromatic Aberration
The Chromatic Aberration slider allows you to change 
the color fringes around the edges of the highlights 
(aperture shapes) that separate dark and bright points 
in your image. 

Settings & Parameters 

Chromatic Aberration - strong & warm
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Brush Size
Determines the size of the brush. 

Brush Smoothness
Determines the edge smoothness of your brush 
strokes. 

Focal Plane Adjustments
This parameter allows you to adjust which part of the 
image you want to be in focus - similar to focusing a 
camera. 

Focal Plane Position (button/slider)
Provides control for focal placement. It is like using the 
focusing ring on a lens to change the area of focus. 

Depth of Field
Increases or decreases the depth of field before/after 
the point of focus. Similiar to changing the aperture of 
a lens (f/1.4, f/8, f/16 etc) 

Bokeh - Selective 
The Bokeh - Selective Effect offers the most control 
over your foreground and backround selections. 

Edit Depth Map (Topaz Smart Brush)
This parameter allows you to create depth maps. Use 
the Smart Brush to identify relative distance of near 
to far objects  - making it easy to select any focal point 
within your image and put the emphasis where you 
want it.

Depth  Value
Paints image depth, using shades of black, white and 
gray. The higher the value the further away it will be. 
The lower the value the closer it is considered.  Selects 
relative distance for the depth map.

Settings & Parameters 
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Aperture Shape
Sets the number of blades in the selected Aperture 
shape, which controls the out-of-focus highlights. The 
higher the blade setting the more rounded the hight-
lights will be.

Blade Curvature
Determines the curvature of the aperture blades. A 
higher setting produces a smoother more rounded 
shape.

Rotation
Rotates the selected aperture shape.

Creamy
Determines the smoothness of the blur.

Highlight Boost
Increases the highlights in the image. 

Highlight Threshold
Determines the span of elements affected by the 
highlight boost slider. A larger threshold allows more 
elements to be affected.

Chromatic Aberration
The Chromatic Aberration slider allows you to change 
the color fringes around the edges of the highlights 
(aperture shapes) that separate dark and bright points 
in your image. 

Foreground Blur Amount
Determines the amount of blur applied to the fore-
ground.

Background Blur Amount
Determines the amount of blur applied to the back-
ground. 

Lens Characteristics
This parameter allows you to adjust how the blur area 
is rendered.

Settings & Parameters 
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Contrast
Adjusts definition between areas of light and dark to 
add more depth.

Saturation
Standard parameter to increase or decrease the focus 
area saturation (richness and brightness ) of the image.

Focus Area Adjustments
Use this parameter to make adjustments to the focus 
area.

Sharpen
Intensifies the sharpness of your image and correlates 
directly to the Sharpness Radius slider.

Sharpen Radius
This parameter correlates to the Sharpness slider and 
should be used sparingly. If extra sharpness in an im- 
age is needed, slowly increase this slider until the best 
results are achieved.

Brightness
Standard brightness adjustment parameter. Increasing 
this parameter increases the focus area brightness of 
the image.

Settings & Parameters 

After Topaz
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Blur Area Adjustments
Use this parameter to make adjustments to the blur 
area.

Brightness
Standard brightness adjustment parameter. Increasing 
this parameter increases the blur area brightness of the 
image.

Contrast
Adjusts definition between areas of light and dark to 
add more depth.

Saturation
Standard parameter to increase or decrease the blur 
area saturation (richness and brightness ) of the image.

Vignette and Grain
Use this parameter to add vignette and grain effects to 
your image. 

Vignette Strength
Controls how heavily the vignette is applied to your 
image. A higher value will produce a darker vignette, 
whereas a smaller value will produce a lighter, more 
opaque vignette.

Size
Controls the size of the applied vignette. A higher value 
will expand the width of the vignette towards the 
edges of your image. A smaller value will contract the 
vignette inward to the center of your image.

Settings & Parameters 

The basic tools for brightnes, contrast and saturation 
are included for convenience. For extended control over 
tone and color in your images, you can use the tools and 

presets found in Topaz Adjust or Topaz Detail. 
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Transition
Determines the hardness of the transition between 
the blurred (out-of-focus) background and the focused 
foreground. The higher the value the softer the transi-
tion will be.

Add Grain
Adds film-like grain to the image for a lightly textured 
and natural look. Correlates directly to the Grain Size 
slider.

Grain Size
This parameter correlates to the Add Grain slider. It 
determines the size of the added grain.

Select Color
Allows you to select the color of the added vignette.

Settings & Parameters 

Before - Rust-colored Vignette

After- Rust-colored Vignette
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Effect Width
Adjusts the horizontal span of the blur effect from cen-
ter point.  A higher value will include more focused area 
from the Effect Center. 

Effect Height
Adjusts the vertical span of the blur effect from center 
point.  A higher value will include more focused area 
from the Effect Center. 

Strength 
Controls how heavily the pinhole effect is applied to 
your image. A higher value will produce lighter edges 
whereas a lower value will produce darker eges. 

Transition
Determines the hardness of the transition between 
the blurred (out-of-focus) background and the focused 
foreground. The higher the value the softer the transi-
tion will be.

Blur Amount
Determines the amount of blur to be applied.

Camera - Pinhole
The Camera - Pinhole effect allows you to create
 effects similar to those you would achieve using a 
Pinhole camera. This effect includes default presets and 
one adjustment tab.

Pinhole Adjustments
Creates and controls the intensity of the applied pin-
hole effect in the image. 

Settings & Parameters 

The pinhole camera effect is a very fun and popular effect. 
Pinhole cameras are cheap (often home-made) camers 
that do not have lenses. Instead, there is a small hole 
which lets in light through the narrow viewfield thus 

creating the pinhole effect. Pinhole images are also know 
for being somewhat grainy and having darker edges. 
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Settings & Parameters 

Before - Pinhole After - Pinhole
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Tilt Shift Adjustments
Simulates the tilt-shift effect and gives you control over 
how and where the effect is applied in your image.

Focus Area Width
Adjusts the horizontal span of the blur effect from cen-
ter point.  A higher value will include more focused area 
from the Effect Position. This parameter correlates to 
the angle parameter.

Transition
Determines the hardness of the transition between 
the blurred (out-of-focus) background and the focused 
foreground. The higher the value the softer the transi-
tion will be.

Blur Amount
Determines the amount of blur to be applied.

Camera - Tilt & Shift
The Camera - Tilt & Shift effect creates a selective focus 
effect similiar to the one achieveable with a tilt-shift 
lens or camera. This is used in the creation of minia-
tures. 

Settings & Parameters 

After - Tilt Shift

Before - Tilt Shift
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Saturation
Standard parameter to increase or decrease the overall 
saturation (richness and brightness ) of the image.

Distortion Adjustments
This allows you to apply and control distortion in your 
image.

Angle
This parameter correlates to the Focus Area Width 
slider. It sets the angle the blur of the focus area width 
is generated. 

Effect Position
1-click selection used to set the center (most focused) 
point of the effect.

Image Adjustments

Brightness
Standard brightness adjustment parameter. Increasing 
this parameter increases the overall brightness of the 
image.

Contrast
Adjusts definition between areas of light and dark to 
add more depth.

Settings & Parameters 

When creating the miniature effect, be sure to use an
 image that has an elevated  viewpoint - this works better 

to create the miniature scene effect. 

Also, once you have created the tilt-shift effect, be sure to 
bump up your saturation to complete the toy miniature 

look in your image. 
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Type
Sets the type of distortion you want to apply to the 
image. 

Pincusion / Barrel
With the pincushion distortion, lines are bowed inward 
towards the center of your image.

With the Barrel distortion, lines are rounded outward from 
the center of your image - similiar to a fisheye effect.

Tangential 
Tangential is a decentering distortion that pulls your image 
lines away (parallel) from the image center.

Settings & Parameters 

Pincushion Distortion

Barrel Distortion

Tangential Distortion

After - Barrel Distortion
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Horizontal Distortion
Controls the horizontal image distortion. A lower value 
will pull and stretch your image more to the right (from 
the Effect Position, set in the Tilt-shift tab). A higher 
value will pull and stretch your image more to the left. 

When used in conjunction with Pincusion/Barrel, this 
slider will evenly pull both sides of your image outward 
(from the Effect Position) when increased or push both 
sides inward towards when decreased. 

When used in conjunction with Tangential, your image 
will be pulled (from the Effect Position) outward or 
inward.

Vertical Distortion
Controls the vertical image distortion. A lower value 
will pull your image upward (from the Effect Position, 
set in the Tilt-shift tab). A higher value will pull your im-
age downward .
 
When used in conjunction with Pincusion/Barrel, this 
slider will pull the top and bottom of your image out-
ward (from the Effect Position) when increased or push 
the top and bottom inward (towards the Effect Posi-
tion, set in the Tilt-shift tab)  when decreased. 

When used in conjunction with Tangential, this slider 
will pull the bottom of your image downward (from 
the Effect Position) when decreased and upward when 
increased. 

Distortion Scale
Image magnification distortion. A higher value will 
increase the magnification.

Settings & Parameters 

Horizontal Distorion Vertical Distorion 
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     Max                      Min      Max                      Min

Max                   Min      Max                          Min

This example image has the 
Effect Position set center 
point. The rendered distortion
effects direclty correlate with 
the Effect position. 

See how the two types of 
distortion: Pincushion/Barrel 
and Tangential are affected 
when their distortion values 
are increased and decreased. 
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Camera - Toy
The Camera - Toy simulates characteristics like those 
seen with Holga and Diana cameras. Typical character-
istics that can occur include: light leaks, chromatic aber-
ration, heavy vignetting,  blur and other distortions. 
This is a creative and artistic type of photography.

Toy Camera Aberrations
This tab allows you to apply and control the distortions 
and aberrations that make the toy camera-like effects 
so unique.

Vignette Strength
Controls how heavily the vignette is applied to your 
image. A higher value will produce a darker vignette, 
whereas a smaller value will produce a lighter, more 
opaque vignette.

Vignette Center
1-click center point selection for placement of your vi-
gnette. The vignette will be applied around this center-
selection.

 Camera Shake
Applies motion blur (in the form of camera shake) to 
the image. A higher value will produce a more blurred 
effect. 

Camera Shake Angle
Determines the angle of the applied camera shake.

Grain Amount
Determines the amount of grain added to the image.

Double Image
Enabling this feature will create a double of your image 
within the image.

Settings & Parameters 
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Placement Adjustments
This allows you to apply and control distortion in your 
image.

Region Size
Allows you to set the span of regions “A” and “B” in 
your image.  A setting of 0 means that the entire image 
is considered region A. As you increase this parameter 
you decrease the span of region A and increase the 
span of region B.

Transition
Controls the transition between Region A and Region 
B. The higher the value the softer (and more blended) 
the transition will be.

Angle 
Adjust the angle of the split between the two color 
tones. You can adjust the angle from 0 to 180 degrees.

Region A Adjustments
Controls the amount of color enhanced in each color 
tone for Region A of your image. 

Cyan Cast A
Controls the Cyan color tones. 
 
Red Cast A
Controls the Red color tones. 

Magenta Cast A
Controls the Magenta color tones.

Green Cast A
Controls the Green color tones. 

Settings & Parameters 

Tip: There is no right or wrong way to apply the toy 
camera enhancements. What makes toy camera images 
so fun is that each is different and unique. So have fun!
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Yellow Cast A
Controls the Yellow color tones. 

Blue Cast A
Controls the Blue color tones. 

Region B Adjustments
Controls the amount of color enhanced in each color 
tone for Region B of your image.

Cyan Cast B
Controls the Cyan color. 

Red Cast B
Controls the Red color. 

Magenta Cast B
Controls the Magenta color.

Green Cast B
Controls the Green color tones. 

Yellow Cast B
Controls the Yellow color tones. 

Blue Cast B
Controls the Blue color tones. 

Image Adjustments
Make basic adjustments to your images brightness, 
contrast and saturation. 

Settings & Parameters 
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Brightness
Standard brightness adjustment parameter. Increasing 
this parameter increases the overall brightness of the 
image.

Contrast
Adjusts definition between areas of light and dark to 
add more depth.

Saturation
Standard parameter to increase or decrease the overall 
saturation (richness and brightness ) of the image.

Saturation Boost
Increase or decrease the saturation of less saturated 
colors in an image.

Shadow
Adjusts the shadows in an image.  Decreasing this pa-
rameter will make shadow areas darker. Increasing this 
parameter will make shadow areas lighter by opening 
them up and revealing previously obscured detail in 
those shadow areas. 

Hightlight
Adjusts the highlights in an image. Increasing this pa-
rameter increases the highlights in an image.

Settings & Parameters 

Tip: There is no right or wrong way to apply the toy 
camera enhancements. What makes toy camera images 
so fun is that each is different and unique. So have fun!

Before - Toy Camera

After - Toy Camera



54

User Manual
To

pa
z 

 L
en

s 
Eff

ec
ts

Edge Transition
The Edge Transition slider controls how quickly one 
area on tone transitions into the next.  This will help to 
further control/enhance the exact look of diffusion you 
would like for your image.

Camera - Diffusion
The Camera - Diffusion simulates characteristics like 
those seen with Diffusion filters, which help soften and 
spread out light. Diffusion filters can also help create a 
hazy or dream-like effect. 

Diffusion Adjustments
Controls how the diffusion is applied to the image.

Softness
Adjusts the softnesss of the image. Increasing this 
parameter will make the image appear to have a softer 
focus.

Diffusion
The diffusion slider controls how much the light is dif-
fused in the image. This can give the image a nice inner 
glow - traditionally used for portraits to soften/smooth 
the skin, especially on females.

Settings & Parameters 

Important: If the softness slider is set to 0 (zero) then the 
other two sliders will not have any affect on the image. 

You must increase the Softness slider in order for the Dif-
fusion and Edge Transition sliders to work.

Before - Diffusion

After - Diffusion
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Filter - Dual Tone
Create color tone effects similar to that achieved with 
color filters. You select the colors and then determine 
the intensity, transition and angle.  

Transition Adjustments
Sets the direction and span of each region, and con-
trols the transition between the two color tones.

Region Size
Allows you to set the span of regions “A” and “B” in 
your image.  A setting of 0 means that the entire image 
is considered region A. 

Settings & Parameters 

Tip: Working with the Angle Parameter
A value of 90 will render an even vertical split.

A value of 180 will render an even horizontal split.

Before - Dual Tone

After - Dual Tone
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Settings & Parameters 
Transition
Controls the transition between Region A and Region 
B. The higher the value the softer (and more blended) 
the transition will be.

Angle 
Adjust the angle of the split between the two color 
tones. You can adjust the angle from 0 to 180 degrees. 

As you increase this parameter you decrease the span 
of region A and increase the span of region B.
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Yellow Cast A
Controls the Yellow color tones. 

Blue Cast A
Controls the Blue color tones. 

Region B Adjustments
Controls the amount of color enhanced in each color 
tone for Region B of your image.

Cyan Cast B
Controls the Cyan color. 

Red Cast B
Controls the Red color. 

Region A Adjustments
Controls the amount of color enhanced in each color 
tone for Region A of your image. 

Cyan Cast A
Controls the Cyan color tones. 
 
Red Cast A
Controls the Red color tones. 

Magenta Cast A
Controls the Magenta color tones.

Green Cast A
Controls the Green color tones. 

Settings & Parameters 
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Contrast
Adjusts definition between areas of light and dark to 
add more depth.

Saturation
Standard parameter to increase or decrease the overall 
saturation (richness and brightness ) of the image.

Magenta Cast B
Controls the Magenta color.

Green Cast B
Controls the Green color tones. 

Yellow Cast B
Controls the Yellow color tones. 

Blue Cast B
Controls the Blue color tones. 

Image Adjustments
Make basic adjustments to your images brightness, 
contrast and saturation. 

Brightness
Standard brightness adjustment parameter. Increasing 
this parameter increases the overall brightness of the 
image.

Settings & Parameters

Before - Dual Tone

After - Dual Tone
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Filter - Fog
This filter simulates a physical fog filter and graduated 
fog filter.

Fog Filter Adjustments
Controls the characteristics of your added fog effects.

Amount
Controls how strong (or thick) the fog effect is. 
The higher the value the more fog that is applied.

Region Size
Determines the size or span of the fog effect. The 
higher the setting the more area that the applied fog 
will cover over throughout your image. 

Transition 
Controls the transition between the fog effect and 
the original photo. The higher the value the softer the 
transition will be.

Angle
Determines the angle of the fog horizon.

Diffusion
Controls how much soft focus effects is applied to the 
effected region and helps to create realistic fog.

Effect Position 
1-click selection used to set the center (most focused) 
point of the effect.

Settings & Parameters 

Adding a Fog effect will alllow you to give your image
 a creative feel that is hazy, dreamy or even mystical.
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Region Size
Determines how much of your image is affected by the 
added color.

Transition
Controls the transition between your image and the 
graduated color added.

Angle 
Adjust the angle of the applied color tone. You can 
adjust the angle from 0 to 180 degrees. 

Effect Position
1-click selection used to set the placement for the color 
effect to be applied.

Select Color 
Allows you to select the color to be added.

Filter - Graduated Color
Creates an effect similiar to that of a graduated color 
filter, which blends a color into a portion of an image 
using a gradual transition.

Graduated Color Adjustments
Adjust the amount of graduated region.

Amount
Determines the intensity (opacity) of the applied color. 
As this slider is decreased the opacity of the color will 
also decrease. 

Settings & Parameters 
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Amount
How much of your image is covered by that decrease in 
brightness.

Transition
Controls the transition between your image and the 
graduated shade added.

Angle 
Adjust the angle of the applied effect. You can adjust 
the angle from 0 to 180 degrees. 

Effect Position
1-click selection used to set the placement for the 
effect to be applied.

Filter - Graduated N.D.
Creates an effect similiar to that of graduated neutral 
density filters, which are used for exposure balance, 
depth-of-field control and controlling overly bright, 
washed out images. They are great for balancing out 
bright skies against darker foregrounds. 

Graduated Neutral Density Adjustments

Brightness
Standard brightness adjustment parameter. Decreas-
ing acts like the filter, allowing lens light in that specific 
area.

Settings & Parameters 

Before - Neutral Density                     After - Neutral Density
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Filter - Polarization
Creates an effect similiar to that of circular polarizer by 
darkening the sky, reducing reflections in water and 
reducing shine in foliage. Another characteristic of the 
polarizer is that in can also increase saturation.

Polarization Adjustments
Adjusts the effects of the polarization applied to the 
image.

Strength 
Determines the intensity of the polarizing effect. The 
higher the value the more stronger the effect and the 
richer the saturation will be. 

Settings & Parameters 

Before - Polarization

After - Polarization

In just one step, you can easily enhance the look of your 
and balance of images without owning a polarizing filter.
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Type 
Select a gold or silver reflector effect.  

Type - Gold and adds a warm light to the shadows.

Type  - Silver adds a more neutral light. 

Strength
Controls how strong the reflector effect is.

Transition 
Controls the transition between the reflector effect 
and the original photo.

Position
Determines the size of the reflector effect.

Direction
Determines the angle of the reflector effect.

Filter - Reflector
Simulates a traditional gold or silver reflector, used to 
redirect light towards a given subject or scene.

Reflector Adjustments
Controls the type, amount and position of the applied 
light boost in your image.

Settings & Parameters 

Want to learn more about the types of filters and how 
they can help improve and enhance your images?

Sign up for a webinar at: www.topazlabs.com/webinars
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Green Cast 
Controls the Green color tones. 

Yellow Cast 
Controls the Yellow color tones. 

Blue Cast 
Controls the Blue color tones. 

Image Adjustments

Brightness
Standard brightness adjustment parameter. Increasing 
this parameter increases the overall brightness of the 
image.

Contrast
Adjusts definition between areas of light and dark to 
add more depth.

Saturation
Standard parameter to increase or decrease the overall 
saturation (richness and brightness ) of the image.

Filter - Single Tone
The Single Tone effect is similiar to using a color filter on 
your camera. It adds shades of any color to an image. 

Color Tone Adjustments

Cyan Cast 
Controls the Cyan color. 

Red Cast 
Controls the Red color. 

Magenta Cast 
Controls the Magenta color.

Settings & Parameters
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Focus Width
Adjusts the horizontal span of the applied blur (from 
the Effect Center). A higher value will include more 
focused area from the Effect Center. 

Focus Height
Adjusts the vertical span of the applied blur (from the 
Effect Center). A higher value will include more focused 
area from the Effect Center. 

Effect Center
1-click center-point selection.

Filter - UV/Haze
The Filter - UV/Haze allows you to reduce UV and elimi-
nate haze from your image by emulating the character-
istics of a UV/Haze filter. 

UV/Haze Adjust
Controls the UV/Haze adjustments made to the image.

Strength
Determines how much UV / Haze reduction is applied 
to an image. 

Filter - Streak
The Filter - Streak option creates motion in an image 
for a streaked or creative blur type of effect. It can also 
produce a ghost-like effect.

Streak Filter Adjustments
Sets the amount of diffusion applied to image.

Motion Amount
Determines the amount of motion movement applied 
to the image. 

Motion Angle
Adjust the angle of the applied applied motion. You can 
adjust the angle from 0 to 360 degrees. 

Settings & Parameters 
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Filter - Warmth
The Filter - Warmth option control the temperature of 
your image by giving it a warm or cool tint. Moving 
the slider towards 1 will add a warmer temperature 
and moving the slider towards -1 will add a cooler tem-
perature.

Settings & Parameters
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Create Blur Adjustments
These parameters are used to set and control the focus 
area and blur amount.

Blur Amount
Determines the amount of blur to be applied.

Focus Width
Adjusts the horizontal span of the applied blur (from 
the Effect Center). A higher value will include more 
focused area from the Effect Center. 

Focus Height
Adjusts the vertical span of the applied blur (from the 
Effect Center). A higher value will include more focused 
area from the Effect Center. 

Effect Position
1-click selection used to set the placement for the blur 
effect to be applied.

Lens - Creative Blur
Creates fun, selective blur effects.  

Settings & Parameters 

Before - Creative Blur

After - Creative Blur
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Blur Amount
Determines the amount of blur applied to image. The 
higher the value the heavier the blur. 

Transition
Determines the transition between the blur and the 
two focus points in your image.

Focus Area 1 Size
Allows you to control the size of your first focus area.

Focus Width 1
Adjusts the horizontal span of  the focus area.  A higher 
value will include more focused area and a smaller 
value will have less focused area.

Focus Height 1
Adjusts the vertical span of  the focus area.  A higher 
value will include more focused area and a smaller 
value will have less focused area.

Lens - Dual Focus
The Lens - Dual Focus option allows you to select two 
focus points within an image, while blurring everything 
else. 

Dual Focus Adjustment
This is where you will select the two focus points and 
apply common adjustments.

Focus Point
This 1-click button allows you to select your two focus 
points within your image. Click on the Focus Point 
button to activate the crosshairs then you can click 
anywhere on your image to select it as the focus point. 
To set the second focal point, simply click on the focus 
point button again to reactivate the crosshairs and 
then select the second focus point in your image. You 
can change focus points at any time by repeating these 
steps. 

Settings & Parameters
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Focus Area 2 Size
Allows you to control the size of your second focus 
area.

Focus Width 2 
Adjusts the horizontal span of  the focus area.  A higher 
value will include more focused area and a smaller 
value will have less focused area.

Focus Height 2
Adjusts the vertical span of  the focus area.  A higher 
value will include more focused area and a smaller 
value will have less focused area.

Settings & Parameters 
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Lens - Fisheye
Creates fun effects similiar to that of a fisheye lens.

FishEye Adjustments
Simulates the fisheye effect using tools to determine 
distortion amount and origination. 

Distortion Amount
Determines the amount of distortion added to the im-
age. The higher the value the more distorted the image 
will be. 

Effect Center
1-click center focal-point selection. 

Image Adjustments

Brightness
Standard brightness adjustment parameter. Increasing 
this parameter increases the overall brightness of the 
image.

Contrast
Adjusts definition between areas of light and dark to 
add more depth.

Saturation
Standard parameter to increase or decrease the overall 
saturation (richness and brightness ) of the image.

Settings & Parameters 

After - FishEye Effect
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Motion Blur

Motion Type
Sets the type of motion that is applied.

Motion Amount
Determines the amount of motion movement applied 
to the image. 

Motion Angle
Adjust the angle of the applied applied motion. You can 
adjust the angle from 0 to 360 degrees. 

Effect Center
1-click center focal-point selection. 

Lens - Motion
Creats a motion blur effect that will give your image 
movement and a sense of speed.

Settings & Parameters

Before - Motion

After - Motion
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Lens - Split Prism
Creates a prism effect that allows you to slice your im-
age up and split or stack those slices.

Split Prism Adjustments
Provides adjustments for creating the split prism ef-
fects.

Prism Splits
Sets the amount of splits your image is broken into.

Mixing Level
Blends the transition between the slices/splits.

Radius
Adjusts the span of each split. The higher the radius 
the longer the span - making each slice wider and less 
in number. The lower the number the smaller the span 
(width) of each slice and the more slices there are. 

Rotation
Rotates the position of each slice. 

Type
Type I is stack effect
Type II is split effect

Effect Center
1-click center-point selection. 

Settings & Parameters 

Before Split Prism After Split Prism
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Brightness
Standard brightness adjustment parameter. Increasing 
this parameter increases the overall brightness of the 
image.

Contrast
Adjusts definition between areas of light and dark to 
add more depth.

Saturation
Standard parameter to increase or decrease the overall 
saturation (richness and brightness ) of the image.

Saturation Boost
Increase or decrease the saturation of less saturated 
colors in an image.

Shadow
Adjusts the shadows in an image.  Decreasing this pa-
rameter will make shadow areas darker. Increasing this 
parameter will make shadow areas lighter by opening 
them up and revealing previously obscured detail in 
those shadow areas. 

Hightlight
Adjusts the highlights in an image. Increasing this pa-
rameter increases the highlights in an image.

xF Options
The xF effect options allow you to individual add 
additional effects to your image. When adding multiple 
effects you will want to click the “Apply” button to 
save those changes before moving on and adding 
more. 

xF - Add Adjustment
Image Adjustments

Settings & Parameters 

When adding additional effects and presets, keep in mind 
that once you click “Apply” you can not undo that applied 
change. Be sure to use the Snap / Recall  features to com-

pare changes before applying.
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When used in conjunction with Pincusion/Barrel, this 
slider will evenly pull both sides of your image outward 
(from the Effect Position) when increased or push both 
sides inward towards when decreased. 

When used in conjunction with Tangential, your image 
will be pulled (from the Effect Position) outward or 
inward.

Vertical Distortion
Controls the vertical image distortion. A lower value 
will pull your image upward (from the Effect Position, 
set in the Tilt-shift tab). A higher value will pull your im-
age downward .
 
When used in conjunction with Pincusion/Barrel, this 
slider will pull the top and bottom of your image out-
ward (from the Effect Position) when increased or push 
the top and bottom inward (towards the Effect Posi-
tion, set in the Tilt-shift tab)  when decreased. 

When used in conjunction with Tangential, this slider 
will pull the bottom of your image downward (from 
the Effect Position) when decreased and upward when 
increased. 

Distortion Scale
Image magnification distortion. A higher value will 
increase the magnification.

Distortion Center
1-click center distortion selection. 

xF - Add Geometric Distortion

Distortion Adjustments

Type
Sets the type of distortion you want to apply to the 
image.

Horizontal Distortion
Controls the horizontal image distortion. A lower value 
will pull and stretch your image more to the right (from 
the Effect Position, set in the Tilt-shift tab). A higher 
value will pull and stretch your image more to the left. 

Settings & Parameters
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xF - Add Sharpening
This effect allows you to add additional sharpening to 
your image. 

Sharpening Adjustments
Controls the amount of sharpening to be applied.

Sharpen
Intensifies the sharpness of your image and correlates 
directly to the Sharpness Radius slider.

Sharpen Radius
This parameter correlates to the Sharpness slider and 
should be used sparingly. If extra sharpness in an im- 
age is needed, slowly increase this slider until the best 
results are achieved.

xF - Add Grain
This effect allows you to apply additional grain to your 
image.

Grain Adjustments

Add Grain
Adds film-like grain to the image for a lightly textured 
and natural look. Correlates directly to the Grain Size 
slider.

Grain Size
This parameter correlates to the Add Grain slider. It 
determines the size of the added grain.

Settings & Parameters 

Tip: Adding grain into your image can give it additional 
texture to make it look more natural.

         Without Grain                      With Grain
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xF - Add Vignette - Selective
This effect allows gives you more control over added 
vignette effects.

Placement Adjustments
Allows you to determine the exact location and span of 
your applied vignette.

Focus Width
Adjusts the horizontal span of the applied blur (from 
the Effect Center). A higher value will include more 
focused area from the Effect Center. 

Focus Height
Adjusts the vertical span of the applied blur (from the 
Effect Center). A higher value will include more focused 
area from the Effect Center. 

Effect Center
1-click center focal-point selection. 

xF - Add Vignette
This effect allows you to add a basic vignette to your 
image. 

Vignette

Vignette Strength
Controls how heavily the vignette is applied to your 
image. A higher value will produce a darker vignette, 
whereas a smaller value will produce a lighter, more 
opaque vignette 

Size
Controls the size of the applied vignette. A higher value 
will expand the width of the vignette towards the 
edges of your image. A smaller value will contract the 
vignette inward to the center of your image.

Transition
Determines the hardness of the transition between 
the blurred (out-of-focus) background and the focused 
foreground. The higher the value the softer the transi-
tion will be.

Settings & Parameters
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Vignette Tone
Determines the strength of the vignette. 

Transition
Controls the transition between your image and the 
Vignette. A lower value will render a harder more 
prominent transition, whereas a higher value renders a 
smoother, more subtle transition. 

Contrast
Adjusts definition between areas of light and dark to 
add more depth.

Brightness
Standard brightness adjustment parameter. Increasing 
this parameter increases the overall brightness of the 
image.

Opacity
Determines the strength of the applied vignette. A low-
er value will render more transparency in the vignette.

Examples above show you what a basic vignette looks 
like (without the image). It’s applied over your image 
to draw attention inward towards the selected center. 

Tonal Adjustments

Select Color
Allows you to select the color of the vignette.

Settings & Parameters 

      Basic Vignette                                       Color Vignette
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Tonal Adjustment
This is where you will fine tune  how the mask/vignette 
selection is applied to your image.

Select A Color
Allows you to select a vignette color to apply.

Contrast
Adjust the contrast of the vignette mask.

Brightness
Controls the brightness of the applied vignette mask. 
A higher value will make it brighter, giving it a more 
opaque look.

Transition
Determines the hardness of the transition between the 
image and the applied vignette mask. The higher the 
value the softer the transition will be.

xF - Add Vignette - Use 
Saved Mask
This effect allows you to select a pre-existing mask to 
add to your image as a vignette. 

Mask Selection 
This is where you will select/load your mask.

Select Saved Mask
Click this button to load a mask from your saved files.

Settings & Parameters
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Workflow
1.  Open your image in Photoshop (or another com-
patible host program) and go to Filters -> Topaz Labs 
-> Lens Effects.

2. Once your image loads,  use the zoom tools to 
zoom in on a specific part of your image.  Then you 
can click on the preview and drag it around until you 
find an area that you like. 

3. Go to your Effects / Presets panel on the left side of 
the screen and select Bokeh - Center Focus from the 
Effects Menu.

Sample Project #1
In this project, we will walk you through a quick 
Bokeh example workflow to help you get acquainted 
with the tools and setup of the new Topaz Lens Ef-
fects. This example will use the Bokeh - Center Focus 
Effect, which is the quickest and most basic way to 
create the bokeh effect in your image. 

Before Topaz Lens Effects

After Topaz Lens Effects

When fist getting intoTopaz Lens Effects you may want 
to explore all of the effects and their associated presets 
before jumping into the workflow. This will give you a 
better idea of the various effects that you can create.  
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Workflow
4. Select a preset and click on it to apply. Be sure to 
scroll through each preset to see which one will work 
as a good starting point for your image. (Don’t worry 
if your subject looks out of focus...we will change that 
next. 

You will notice in the Presets menu (below Effects) 
that the default bokeh presets pop up, and that the 
tools in your tools panel on the right side of your 
screen also change accordingly. 
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Workflow
5. Go to the Bokeh Adjustments and click on the Effect 
Center button.  You will see a small plus sign that will 
allow you to click on your image in the preview win-
dow to set the effect center - your applied blur should 
shift after resetting the Effect Center.  We clicked 
right in the center of the rose.

You are welcome to select any preset you’d like...or 
you can skip the presets and work solely with the slid-
ers. For this image we selected the Extra Creamy pre-
set. Again, don’t worry if your focal point is effected by 
the blur. We will correct that in the Bokeh Adjustments 
tab by setting the Effect Center.
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Workflow
Be sure to use the Original and Preview buttons to see 
your before and after for comparison. You can also 
use the spacebar shortcut key.

9. Go to the Lens Characteristics tab. Here you can 
make changes to the aperture shape and rotation of 
the bokeh highlights in your image. You can also ad-
just the intensity of the highlights and control 
chromatic aberration cast from those highlights.

6. Adjust the blur slider to apply the desired amount 
of blur to your image. 

7. Adjust the Focus Width and Focus Height sliders. 
These sliders adjust the horizontal and vertical span 
(respectively) of the applied blur in your image. A 
higher value will include more focused area (from 
your Effect Center) whereas a smaller value will in-
clude less focus and more blur.

8. Adjust the Transition slider to change the hardness 
of the transition between the in-focus and out-of-fo-
cus areas of your image. A smaller value will give your 
a harder, more visible transition. A higher value will 
give you a softer more diffused transition.

You can change the center focus in your image at 
anytime by clicking the Effect Center button and 
then selecting the desired area on your image. 
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After making your adjustments here in the Add Ad-
justment option, you can click “Apply” to save these 
changes and then add more. 

Or if you are completely finished with your image and 
are  happy with your adjustments you can click OK 
and watch your image transform. 

In the final image, you can see how the applied bokeh 
blurs the bottom and egdes of the image, moving 
inward towards the rose. 

Once you are happy with your Bokeh Adjustments and 
Lens Characteristic Adjustments you can either click 
OK to process your image or you can click Apply to add 
more effects. 

So, for example, you may want to boost the saturation 
in your image just a bit. Go ahead and click the Apply 
button. You will see the progress bar at the bottom of 
the screen move as your changes are being processed.  
 
After that, go back to your Effects menu and select the 
xF - Add Adjustment option. This will bring up some de-
fault presets for additional enhancements you can add.  
You can go to your Image Adjustments tab on the right 
side of the interface to have more control and manually 
adjust the additional image adjustments to be added.

 

Workflow

xF stands for additional function. You can add 
these effects to your image and stack them any 
way you’d like using the “Apply” button. 
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Workflow

Before Topaz Lens Effects
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Workflow

After Topaz Lens Effects
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Sample Project #2
In this project, we will walk you through an example 
workflow that uses the Bokeh - Selective effect to 
demonstrate the use of the smart brush for creating a 
depth map.

1.  Open your image in Photoshop (or another com-
patible host program) and go to Filters -> Topaz Labs 
-> Lens Effects.

2. Once your image loads,  use the zoom tools to 
zoom in on a specific part of your image.  Then you 
can click on the preview and drag it around until you 
find an area that you like. 

3. Go to your Effects / Presets panel on the left side 
of the screen and select Bokeh - Selective from the 
Effects Menu.

Workflow

Before Topaz Lens Effects

After Topaz Lens Effects
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Workflow
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to complete the depth map, or you can start over. 

5. (To star over) Go ahead and set your Depth Value 
slider to 255 (either by dragging the slider or by click-
ing the 255 button) and then click on the Reset button 
that has the green icon next to it. This will reset the 
depth map and fill it with white.

4. Your first steps will be in the Edit Depth Map tab. 
This will automatically open up the split screen view, 
which will help you visually when creating the depth 
map. 

When your mask preview loads there may be a partial 
depth map outline that loads with it. You can tweak it, 

Workflow
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The black portion of your image will be the most 
focused part of your image and will taper into the blur 
or white portion of your image. 

You will be able to control the look and intensity of 
the blur and transition using the other tabs once you 
have finished the depth map creation. 

For this image, we want the girl’s face to be the most 
focused part and the brick area behind her to be out 
of focus. 

6. The first thing will be to create the depth map.  
Click on the Use Gradient Brush checkbox to enable it. 

7. Then set your depth values near to far, where black 
(value 0) represents the nearest point and white 
(value 255) represents the furthest point. 

Workflow

Example of a gradient depth 
map in progress

Tip:  Larger the brush size, more it will affect the adjacent 
areas. Smaller the brush size, more strokes it will need. 

So pick brush size and brush softness based on the need.
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9. Switching back to the Smart Brush tool (by un-
checking the Use Gradient Brush) we will set the 
Depth value to 0, select a small brush size and paint 
in her feet. As you make brush strokes the map will 
automatically help fill in corresponding sections.

8. We will click at the bottom of the image and drag 
our cursor up to the top of the image to create the 
gradient. You may find that you need to do more than 
one stroke to create the optimal gradient for your 
image. 

Workflow
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Workflow
12. We will click in the middle of the girls face to select 
the gray color value and then set our brush size and 
brush it in. Fill free to do this in any necessary areas 
and switch back to the gradient tool if needed. 

13. Once the depth map is complete we can move on 
to add the blur effect and adjust our focal point. Click 
on the Focal Plane Adjustments tab - this will auto-
matically adjust your preview window. 

10. If you notice certain parts of your image that are 
not properly filled then you can fill those areas us-
ing your brush tool. For example, the girls head here 
could use a small touch up.

11. Select the green eye dropper tool - this will allow 
you to click anywhere on the image to select that 
color value. 
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16. Adjust the Background and Foreground  Amounts. 
For most images you will want to set your Foreground 
Blur Amount to zero - so that your foreground is in-
focus. 

17. Slowly increase the Background Blur Amount until 
you are satisfied with the amount of blur in your im-
age. 

18. We will work our way down each adjustment tab. 
For this image the only adjustments made in the Lens 
Characteristics tab was to increase the creamy slider. 
This offers a smoother blur effect. 

If your image has highlights in the background then 
you can adjust the other parameters in this tab to 
enhance those highlights. See pages 33 and 34 for 
details.

Here in the Focal Plane Adjustments is where our 
depth map work comes to life. Here we will make 
selections as to what part of the image we want to be 
infocus - similar to focusing a camera. 

14. First, we will set the Focal Plane Position. You can 
do this using the Select Focal Plane Button (easiest 
way) or by adjusing the Focal Plane Position slider 
(more incremental flexibility). 

Our Focal Plane Position was set on the girl’s face. 

15. Next, you will need to set your depth of field - this 
is similar to changing the aperture of a lens. For this 
image we used a high depth of field setting. 

Workflow
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Workflow
21. If desired, using the Vignette and Grain tab, you 
can add a vignette to darken the edges and draw 
more attention inward. 

Increase the grain slider to add grain which will give 
the image just a little texture to make it look more 
natural. And that’s it! You can click OK to process your 
image. 

19. In the Focus Area Adjustments we slightly in-
creased all of the parameters to help our focal point, 
the young girl, stand out more from the background. 

20. In the Blur Area Adjustments we slightly de-
creased the brightness slider, and slightly increased 
the contrast and saturation sliders.
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Workflow

Before Topaz Lens Effects
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Workflow

After Topaz Lens Effects
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Workflow
When creating this image we also used the new “Ap-
ply” feature to add sharpening and vignette effects. 
After the FishEye effect is created, we will show you 
how to add on additional adjustments as well.

1.  Open your image in Photoshop (or another com-
patible host program) and go to Filters -> Topaz Labs 
-> Lens Effects.

2. Once your image loads,  use the zoom tools to 
zoom in on a specific part of your image.  Then you 
can click on the preview and drag it around until you 
find an area that you like. 

3. Go to your Effects / Presets panel on the left side of 
the screen and select FishEye from the Effects Menu.

Sample Project #3
In this project, we will walk you through a quick exam-
ple workflow to show you how to create neat FishEye 
Effects using the effects and presets in Lens Effects.

Before Topaz Lens Effects

After Topaz Lens Effects

When fist getting intoTopaz Lens Effects you may want 
to explore all of the effects and their associated presets 
before jumping into the workflow. This will give you a 
better idea of the various effects that you can create.  
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Workflow
4. Select a preset and click on it to apply. Be sure to 
scroll through each preset to see which one will work 
as a good starting point for your image. (Don’t worry 
if your focus is not where you want it...we will change 
that next. 

You will notice in the Presets menu (below Effects) 
that the default fisheye presets pop up, and that the 
tools in your tools panel on the right side of your 
screen also change accordingly. 



98

User Manual
To

pa
z 

 L
en

s 
Eff

ec
ts

Workflow
5. Go to the Fisheye Adjustments and click on the Ef-
fect Center button.  You will see a small plus sign that 
will allow you to click on your image in the preview 
window to set the effect center - your applied effect 
should shift after resetting the Effect Center. 

You are welcome to select any preset you’d like...or 
you can skip the presets and work solely with the slid-
ers. For this example we selected the Extreme FishEye 
preset, however we will be lowering the effects of it 
slightly. 
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Workflow
7. The Image adjustments tab allows you to adjust 
brightness, contrast and saturation in your image.  
Each slider was slightly increased for this image. 

6. Adjust distortion amount to change the intesity of 
the effect. The higher the value the more distorted the 
image will be and the more rounded it will appear. For 
this example we slighly lowered the Distortion Amount 
slider to lessen the effect. 

Use the Original and Preview tabs (or the spacebar 
shorcut key) to compare the before and after preview 
of your image. You can also change to the split view 
preview using the split view buttons at the top right 
of your Lens Effects interface. 

Once you are happy with your adjustments in FishEye 
Adjustments you can move on to the Image Adjust-
ments tab. 

Don’t worry about the black border that appears 
around the fisheye effect. We will show you how 

to remove that in Photoshop afterwards. 
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Sharpening is going to help bring out lines and text 
that extends down the corridor.

11. Next, You can go to your  Sharpening Adjustments 
tab on the right side of the interface to have more 
control and manually adjust the Sharpen Amount and 
Sharpen Radius sliders. 

For this image we simply added the Sharpening III 
preset and did Not make any additional adjustments, 
however you are welcome to manually adjust the slid-
ers to meet your image needs - just be sure not to over-
sharpen your image. 

12.After making your adjustments here in the Add 
Adjustment option, you can click “Apply” to save these 
changes and then add more. 

Or if you are completely finished with your image and 
are  happy with your adjustments you can click OK 
and watch your image transform. 

Since we will also be adding a vignette effect to this 
image, we will click “Apply” to save the sharpening 
adjustments and then move on.

8. Once you are happy with your FishEye Adjustments 
and Image Adjustments you can either click OK to pro-
cess your image (and save it back to Photoshop or your 
other host program) or you can click Apply to add more 
effects. 

9. So, we are going to continue on by adding some 
sharpening and vignette effects. Go ahead and click 
the Apply button. You will see the progress bar at the 
bottom of the screen move as your changes are being 
processed.  
 
10. After that, go back to your Effects menu and select 
the xF - Add Sharpening option. This will bring up some 
default presets for a few sharpening options that you 
can easily add.  

Workflow

xF stands for additional function. You can add 
these effects to your image and stack them any 
way you’d like using the “Apply” button. 
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Workflow
13. After that, go back to your Effects menu and select 
the xF - Add Vignette - Selective option. This vignette 
option gives you maximum flexibility over how your 
vignette is applied. 

The vignette feature is going to darken the edges a 
little bit and help draw attention to the center of the 
image and down the corridor. 
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The Tonal Adjustments allow you to determine the vis-
ibility of the applied vignette and how it transitions into 
your image. 

We applied a very subtle vigentte to this image, which 
helps to gently draw the eye inward and down the 
corridor. You are welcome to tweak the vignette effect 
to your liking. You can also make the vignette color by 
clicking the “Select Color” button and choosing a color 
tone. 

After making your adjustments you can click “Apply” 
to save these changes and then add more.  Or if you 
are completely finished with your image and are  happy 
with your adjustments you can click OK and watch 
your image transform.  We’re finished, so we will click 
“OK” and process the final image. 

After selecting the xF - Vignette Selective effect, go to 
your tool tabs on the right side of the interface to have 
more control and manually adjust how the vignette is 
applied to your image. 

14.  Click the Effect Center button and then click on 
your focus point in your image that you want to center 
the vignette around. 

15. Use the Placement Adjustments tab to determine 
how the vignette is placed in your image. 

The Focus Width will adjust the horizontal span of the 
vignette from your selected effect center, and your Fo-
cus Heigh will adjust the span vertically from the effect 
center. Keep in mind that a higher value will include 
more focused area from the Effect Center. 

Once the vignette placement is set we can then adjust 
the intensity of the applied vignette using the Tonal 
Adjustment tab. 

Workflow

Using a higher Vignette Tone will make your 
vignette lighter. A lower tone will make the 

vignette tone darker. 
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Workflow

using  shortcut keys CMD+V (Mac) or CTRL+V (Win-
dows). If using the copy and paste technique then be 
sure to hide any original layers underneath the copied 
image layer in your layers palette. 

Cropping the FishEye Result

Once your image has processed and is returned back 
to Photoshop (or your other image editing program) 
you will notice that it still has a black border. 

We are going to show you two ways that you can eas-
ily get rid of it and just focus in on the applied effect. 

Go to your Photoshop tool palette and select the Crop 
tool. Draw your crop frame from corner to corner, 
inside of the fisheye effect, and then hit the “enter” 
key to apply the cut. 

Another way to do this (without cutting the image) 
would be to select your marquee tool from your tool 
palette to make the square selection. Then use your 
shortcut keys CMD+C (Mac) or CTRL+C (Windows) to 
copy the selection and then paste it on a new layer After  Photoshop Crop

After FishEye Effect
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Workflow

Before Topaz Lens Effects
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Workflow

After Topaz Lens Effects
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Glossary
Color - The human perceptual response to different 
wavelengths of light impinging on the photo recep-
tors in the retina.

Color Cast - Tint or light hint of colour evenly cover-
ing an image - typcially an unwanted side effect. It is 
usually most visible in light or medium density neutral 
tones.

Color Profile - defines the range of colors that can ap-
pear in a digital photo.

Contrast - The difference between light and dark 
values. 

Depth of Field (DOF) - The amount of distance be-
tween the nearest and farthest objects that appear in 
acceptably sharp focus in a photograph. Depth of field 
depends on the lens opening, the focal length of the 
lens, and the distance from the lens to the subject.

Desaturate - Decreasing the intensity of a color (hue).

Distortion - Optically, where straight lines are not ren-
dered perfectly straight in a focused image. The two 
types of “distortion” are barrel and pincushion. 

Download - The process of transmitting or transfer-
ring data from one device to another.

Export - Outbound data transfer in a format that can 
be used by other programs.

FishEye -An ultra-wide angle lens which purposely 
introduces barrel distortion so straight lines near the 
edges of the frame appear to curve out. 

Achromatic - Without color.

Adjustment Layer – A layer that allows you to adjust the 
look of an original image with out making it permanent. 
With adjustment layers you can make various changes to 
a layer without damaging it and go back and readjust it at 
anytime.

Algorithm - Any bit of code or programming that de- 
fines a process.

Aperture - the opening formed by the blades of the 
iris in the lens that light passes through. 

Barrel Distortion - type of image distortion that occurs 
when the position of the camera lens is at it’s widest 
angle. This tends to create a rounded or curved-look-
ing efffect. 

Blur - Make or become unclear or less distinct.

Bokeh - A word, of Japanese origin, used to describe 
the out-of-focus (blurred) elements in an image.

Brightness - The degree to which a color sample ap-
pears to reflect light. 

Chroma - Purity or intensity of color. The difference 
of a color against the brightness of another color that 
appears white under similar viewing conditions. 

Chromatic Aberration - A type of image distortion 
that usually appears as a rainbow on the edge of ob-
jects towards the outside of an image. Occurs when 
light rays passing through a lens focus at different 
points, depending on the light wavelength.
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Glossary
Neutral Density Filter - A dark, color-neutral filter 
used to control the amount of light reaching the film.

Opacity – The amount of transparency a layer has.

Pan and Zoom - A useful function that allows users to 
magnify the captured image in the preview and then, 
by using the cursor, to move or pan around the image. 
Typically Pan and Zoom allows users to magnify the 
image 2x or 4x time.  By magnifying the images and 
zeroing in on a specific section, you can see details 
not visible when the entire image is sized to fit the 
preview.

Parameter - A numerical or other measurable factor 
forming one of a set that defines a system or sets the 
conditions of its operation.

Photo-editing or Imaging software – Programs in 
which you can alter your photos and / or create digital 
images.  Depending on the software, you can improve 
exposure, color and other attributes of your picture, 
paint on it, add type, apply special effects, remove 
noise, resize it, combine it with other pictures, pre-
pare it for e-mail or posting on the web, output it to a 
printer, or do any number of other manipulations or 
edits.

Plane - An imaginary line or field which lies perpen-
dicular to the optical axis. 

Plug-in - A computing feature with the ability to be 
added to a system to give extra features or functions.

Preset - A pre-defined combination of parameters and 
settings that is saved into a folder within Topaz Lens 

Filters - Transparent lens attachments used to change 
the color, or other characteristics, of an image. 
Focal Plane -  The area of the camera where the lens 
focuses on the film.

Focal point - The point on the optical axis where light 
rays form a sharp image of a subject. An ideal lens 
would allow light rays to reflect from a subject, travel 
through the optical axis and converge to a point after 
they pass through the lens.

Focal Length - The distance from the optical center of 
a lens to the image plane when the lens is focused to 
infinity.

Grain - Lightly-speckled noise that is used to apply a 
more natural look to an image.

Geometric Distortion - 

HDR (High Dynamic Range) - Allows a greater dynamic 
range of luminances between the lightest and darkest 
areas of an image than standard digital imaging tech-
niques or photographic methods.  This wider dynamic 
range allows HDR images to more accurately repre-
sent the wide range of intensity levels found in real 
scenes, ranging from direct sunlight to faint starlight.

Hightlights - The bright to white range of tones in an 
image.

Hue - One of the main properties of a color, described 
with names such as “red”, “yellow”, etc.

Import - Inbound data transfer into a file or docu-
ment.
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Glossary
Effects. Topaz provides default presets.  A preview of 
each preset can be seen in the preset preview win-
dow located at the top left hand side of the interface 
above the preset list. 

Preview- Shows the processed preview of the image.

RAW image - An image file format that contains un- 
touched, “raw” pixel information straight from the 
digital camera’s sensor.  It has yet to translate the in-
formation in each pixel into the full color information, 
so this format offers more control over how the final 
JPEG or TIFF image is generated. 

Refine – Improve (something) by making small changes to 
make it more subtle and accurate. 

RGB - Red, Green, Blue.  The color model that is used 
in digital cameras and by computer monitors.

Saturation - The difference of intensity within a spe-
cific hue.

Selective Focus - Use of limited depth of field to focus 
sharply on a specific object in a scene, while other 
parts are clearly out-of-focus.

Shadow - A dark area or shape produced by a body 
coming between the rays of light and a surface.

Sharpness - The clarity of detail in a photo.

Smoothing - To make a surface more regular or con- 
sistent; free from perceptible projections, lumps, or 
indentations.

Tone - The degree of lightness or darkness. 

Vignette- A fall-off or blockage in brightness at the 
edges of an image. 

Wide-Angle Lens - A lens that has a shorter focal length 
and a wider field of view (includes more subject area) 
than a normal lens.
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empty spot and paste the Topaz_Lenseffects.plugin file 
into the Photoshop Plug-Ins folder. 
3. Quit and restart Photoshop and Topaz Lens Effects 
will appear in your Filters menu. 

“Do you have any other Lens Effects tutorials?”
Yes, please see pages 79, 86 and 96 of this Topaz Lens 
Effects user guide, and also visit: http://www.topazlabs.
com/tutorials/lenseffects

“I do not have Photoshop, will  Lens Effects work with 
my Elements, Aperture, Lightroom, iPhoto Paint Shop 
Pro, Photo Impact or Irfanview?”
Yes, you can use Topaz Lens Effects with any of the 
above host programs.  However, to use Lens Effects in 
Aperture, Lightroom or iPhoto, you will need to down-
load the free Topaz Fusion Express plug-in.  For more 
information please visit: www.topazlabs.com/fusion

“What are the limitations of the trial version of your 
software?”
The only limit on the trial versions of the Topaz plug-ins 
is time.  The free trial versions are designed to enable 
you to experience the full functionality of our plug-ins 
for a 30-day trial period.  After the trial period is up, you 
will only be able to use the Topaz software by purchas-
ing it.  You will then receive a license key to activate the 
plug-in, and the trial version will automatically become 
the full version with no time limitations.          

“I need a Topaz Lens Effects trial key.” 
Visit http://www.topazlabs.com/downloads for a trial 
key.  Please check your Spam folder because your 
Spam filter sometimes filters out the automated email. 

If you need more time to evaluate, please contact us at: 
www.topazlabs.com/support for an extended trial key. 
 

 “I can’t find Topaz Lens Effects in the Photoshop Fil-
ters menu.” 
If you’re using Windows: 
1. Go to C: \ Program Files \  Topaz Labs \ Topaz Lens Ef-
fects \ Plugins. Right click the file “tllenseffects” (it’s an 
8bf file)  and click “Copy”. 
2. Go to your Photoshop Plug-Ins folder, usually located 
at C: \ Program Files \ Adobe \ Adobe Photoshop CSx \
Plug-Ins. First, delete anything that is currently there 
that has to do with Topaz Lens Effects This includes any 
folder that might be labeled “Topaz Lens Effects” or 
any tlenseffects.8bf file. After doing that, right-click on 
any empty space and click “Paste”. 
3. Quit and restart Photoshop and Topaz Lens Effects 
will appear in your Filters menu. 

If you’re using Mac: 
1. Go to /Library/Application Support/Topaz Labs/
LensEffects/Plugins and right-click Topaz_Lenseffects.
plugin. Click “Copy”. 
2. Go to Applications/Adobe Photoshop CSx/Plug-Ins 
(or wherever your Photoshop Plug-Ins folder is lo-
cated). Delete any current reference to Topaz Lens 
Effects. Afterwards, right-click any 

Frequently Asked Questions
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Frequently Asked Questions
“If I use the 30-day trial version will I need to uninstall 
the trial version before I upgrade to a full version?”
No, the Topaz trial software is designed to be unlocked 
to become the full version simply by entering a license 
key.  The full license key will be e-mailed to you immedi-
ately after you purchase the software.

“Where do I enter my key?”
To enter your key please open an image in Photoshop. 
Go to Filter -> Topaz Labs -> Lens Effects. Once the 
program opens go to Menu -> Enter Key.  Then copy & 
paste or type in your license key and then select OK.

“I had Topaz Lens Effects as a trial, then I purchased. 
How do I enter my new license key?”
You can enter your new license key by opening up an 
image in Photoshop and go to Filter -> Topaz Labs -> 
Lens Effects -> Menu -> Enter Key.  Please remove the 
trial key and enter your new purchased license key, 
then select OK and you are all set. 

“My Topaz Lens Effects key doesn’t work!”
There are a couple of reasons why Topaz Lens Effects 
might think your key is invalid.

First, make sure that your key is in the proper format. 
It’ll be in the format “xxxxxx-xxxxxx-xxxxxx-xxxxxx-
xxxxxx” and will be all numbers in 30 digits in five 
groups of six (no letters). 

Second, make sure that as you’re entering the key 

there is nothing in the space beforehand.  This means 
clicking, pressing Ctrl-A, and hitting delete to make sure 
that absolutely nothing is in that field before you paste 
in the key.

If it doesn’t work when you copy and paste, try typing 
it out, and vice versa.

My Topaz filters are grayed out in the filter menu. 
Please make sure that you are using a 8-bit or 16-bit 
image that is in RGB color mode.  Also, if your project 
includes adjustment layers please make sure that you 
are not on an adjustment layer.  You will need to select 
the image layer.  This will allow you to access your To-
paz programs. 

I have a question not listed here. 
Please visit our knowledge base online at: 
http://www.topazlabs.com/support/kb/

If you are not able to find the answer there then con-
tact our support specialists online at: www.topazlabs.
com/support or e-mail customer support at: help@
topazlabs.com

http://www.topazlabs.com/support/kb/
http://www.topazlabs.com/forum 
http://www.topazlabs.com/forum 
mailto:support%40topazlabs.com?subject=Questions%20About%20ReMask%202
mailto:support%40topazlabs.com?subject=Questions%20About%20ReMask%202
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Connect with Topaz

Follow us on Twitter for notifications of 
recent news and easily get in touch with us 

whenever you feel like it!

Find us on our Facebook page and network 
with other Topaz users!

Participate in the entirely user-led Topaz 
Flickr group for a helpful and highly active 
community for Topaz Photoshop plug-ins!

Subscribe to our YouTube channel to keep 
up with any newly released product video 

tutorials!

Check out our new Forum and our blog for 
tutorials, tips and updates from Topaz Labs!

http://www.topazlabs.com/forum
http://www.facebook.com/pages/Topaz-Labs/19955996369
http://www.flickr.com/groups/topaz
http://twitter.com/topazlabs
http://www.youtube.com/topazlabs
http://www.topazlabs.com/forum
http://www.topazlabs.com/blog
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Topaz Labs LLC, a privately owned company in Dallas, Texas, focuses on developing advanced video and image enhance-
ment technology. With today’s widespread use of digital still cameras, digital video cameras, and HDTV, the need for high-
quality digital images and videos has greatly increased. Topaz Labs’ mission is to bring practical state-of-the-art image and 
video enhancement technology to both professionals and consumers.

Contact Information
 

Topaz Labs LLC
4100 Spring Valley Road
Suite 103 
Dallas, TX 75244

Technical Support
Visit: http://topazlabs.com/support/
Email: help@topazlabs.com

For more information
info@topazlabs.com

Copyright © 2010 Topaz Labs, LLC. All rights reserved. http://www.topazlabs.com
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Be sure to check out the complete line up of Topaz products. 
Image Plug-ins    

Go to http://www.topazlabs.com/downloads to get your 30-day free trial!

Ultimate control over 
image exposure, detail, 
and color gives you the 
power to make your 
photos pop.

Specializes in creat-
ing crisp and stylized 
images. Also features 
extensive smoothing 
capabilities. 

Advanced noise reduc-
tion filters noise while 
maximizing and retain-
ing image detail simply 
and effortlessly.

Takes any of your 
regular photos and ef-
fortlessly turn them into 
beautiful works of art.

Specializes in overall 
image improvement. 
Features sharpening, re-
constructing, enlarging, 
high-quality noise 
removal and JPEG arti-
fact damage tools. 

Increase video quality with this suite 
of video enhancement filters utilizing 
super-resolution technology. 

Advanced JPEG artifact 
reduction filters elimi-
nate JPEG compression 
artifacts while preserv-
ing image detail like 
never before. 

Video Plug-ins 

3 levels of intricate and 
specific detail enhance-
ment for naturally 
enhanced images with 
no halos. 

Bring the power of 
Topaz to your Aperture, 
iPhoto and Lightoom 
workflow with the new 
Fusion Express plug-in.

Remove unwanted 
backgrounds from your 
digital images quickly 
and easily with the new 
Topaz ReMask. 

Easily and efficiently capture video 
frames and significantly increase their 
quality and resolution with this stand-
alone Windows application. 


